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Part 1: NCS Overview 

This section describes the NCS architecture and how to install and start the NCS system. It includes the following sections: 
System Introduction, System Requirements, Installation, Getting Started with the NCS System, and NCS Client Overview. 
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System Introduction 

The NUUO Central Management System (NCS) is a powerful system which brings traditional central management systems 
out of the control room through Internet access. The network-based key operation system can manage unlimited combinations 
of analog and network cameras worldwide, via unlimited working stations in different locations. NCS is the universal solution 
for large scale projects. 

 

Client/Server Architecture 
The NCS System uses a client/server architecture to manage unlimited recording systems. These send events to the NCS 
Alarm Server. After filtering the events, the NCS Alarm server sends alarm logs of qualified events to an SQL Server (SQL 
database) and NCS Client systems. The NCS Matrix system is controlled by NCS Client users. The NCS Client system 
allows users in different locations to log in to the NCS Alarm server and, if they have the authority, to change the system 
configuration. 

 

Definition of Terms: 

Terms Descriptions 

NCS System All components of NUUO Central Management system. 

Recording Server Front end servers of the NUUO Central Management system, consisting of NUUO Video 
Recording systems which send events to NCS Alarm Server. 

SQL Server Database of NUUO Central Management system, which backs up alarm logs.  

NCS Alarm Server Alarm Server of NUUO Central Management system, which filters events in order to send 
out alarms, and saves configuration of NCS system. Abbreviate NCS Server or Alarm 
Server. 

NCS Client Client end software of NUUO Central Management system, which is used to log in to the 
Alarm Server. 

NCS Matrix Video Matrix to view live video, controlled by NCS Client. 
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System Requirements 

System Setup 
There are three scenarios for NCS system setup. Depending on customers’ budget and the size of the project, customers 
can choose a suitable scenario. The system requirements for each scenario are detailed below. 

Scenario A: Using one PC for all installed elements 

 
 

 PC1 
CPU  Intel Core 2 Quad Q9550 @ 2830MHz 
RAM  2 GB  

Hard Disk 250 GB or above 

Mother-board  Intel 945 or 965 chip (for single monitor) 
Intel P35/975 chip or nVidia nForce 650i chip (for multiple monitors) 

Display  ATi X4350 or above, nVIDIA GeForce 9500series or above  
Ethernet  100 baseT or above, Gigabit LAN recommended  

OS  MS Windows XP Pro SP3 / Windows Vista/ 2003  

 

Scenario B: Using three PCs with NCS Client and NCS Matrix on PC1, NCS Server and SQL Server on PC2, and NCS 
Matrix on PC3 

 
 

 PC1 PC2 PC3 

CPU Intel Core 2 Quad Q6660 @ 
2400MHz 

Intel Core 2 Duo 
E4500 

Intel Core 2 Quad Q6660 
@ 2400MHz 

RAM 2 GB 2 GB 2 GB 

Hard Disk 250 GB or above 250 GB or above 250 GB or above 

Display ATi X4350 or above ATi X1600 or above ATi X4350 or above 

Mother-board Intel 945 or 965 chip (for single monitor) 
Intel P35/975 chip or nVidia nForce 650i chip (for multiple monitors) 

Ethernet 100 baseT or above, Gigabit LAN recommended 

OS MS Windows XP Pro SP3 / Windows Vista/ 2003 
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Scenario C: Using four PCs with NCS Client and NCS Matrix on PC1, NCS Server on PC2, SQL Server on PC3, and NCS 
Matrix on PC4 

 

 
 

 PC1 PC2 PC3 PC4 

CPU  Intel Core 2 Quad 
Q6660 @ 2400MHz

Intel Core 2 Duo 
E4500 

Intel Core 2 Duo 
E4500 

Intel Core 2 Quad 
Q6660 @ 2400MHz

RAM  2 GB  1 GB 1 GB 2 GB 

Hard Disk 250 GB or above 250 GB or above 250 GB or above 250 GB or above 

Display  ATi X4350 or above  ATi X1600 or above ATi X1600 or above ATi X4350 or above

Mother-board  Intel 945 or 965 chip (for single monitor) 
Intel P35/975 chip or nVidia nForce 650i chip (for multiple monitors) 

Ethernet  100 baseT or above, Gigabit LAN recommended  

OS  MS Windows XP Pro SP3 / Windows Vista/ 2003 

 

Multiple Monitor Configuration 
For a PC running the NCS Client and NCS Matrix, it is suggested that three monitors are used: one to display the Map 
window and the System Configuration window, one to display the Alarm Overview window, and one to display the live 
video feed matrix. This enables efficient use of the system and saves hardware costs. 

PCs using multiple monitors in this way should have a Intel P35/i975x motherboard which can support two display cards. 
Each display card should be the same model, to avoid hardware conflicts. 
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Installation 

The NCS Installation CD contains the software you need to run the complete NCS system. If you are installing the system 
on multiple PCs as described earlier, install the appropriate software for each PC: 

 For the PC running SQL Server, install SQL Server 2005 Express.  

 For the central server PC, install NCS Server 

 For client PCs, install NCS Client 

 For PCs displaying video matrixes, install NCS Matrix. 

The following sections describe installation of each element of the NCS system. 

SQL Server 2005 Express 
To install SQL Server 2005 Express: 

1. Insert the NCS installation CD. 

 

2. In the Welcome to NCS window, click SQL Server 2005 Express. 

 

 

If you do not have Microsoft .Net Framework 2.0 and Windows Installer 3.1 installed, a message will 
appear. Download and install the application from the link in the message or from the toolbox directory of 
installed CD. 

 

 

3. In the End User License Agreement dialog box, read the terms, check I accept the licensing terms and 
conditions, and then click Next. 
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4. In the Installing Prerequisites dialog box, click Install to continue update, and then click Next to continue 
installation. 

 

5. In the Welcome to the Microsoft SQL Server Installation Wizard dialog box, click Next to install. 

 

6. In the System Configuration Check dialog box, click Next. 

 

7. In the Registration Information dialog box, enter your name and company, and then click Next. 
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8. In the Feature Selection dialog box, select Database Services, and then click Next. 

 

9. In the Authentication Mode dialog box, enable Mixed Mode option, and then enter and confirm a password. 

 

10. In the Configuration Options dialog box, select Enable User Instances option, and then click Next. 

 

11. In the Error and Usage Report Settings dialog box, you do not need to select any option. Click Next. 
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12. In the Ready to install dialog box, click Install. 

 

13. In the Setup Progress dialog box, wait for installation finish, and then click Next. 

 

14. In the Completing Microsoft SQL Server 2005 Setup dialog box, click Finish 

NCS Server 
To install NCS Alarm Server: 

1. Insert the NCS installation CD. 
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2. In the Welcome to NCS window, click NCS Server. 

 

3. In the InstallShield Wizard dialog box, click Next to continuous. 

 

4. In the License Agreement window, read the terms, select I accept the terms of the license agreement, and 
then click Next. 

 

5. In the Customer Information window, enter your name and company, and then click Next. 
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6. In the Setup Type window, select Complete, and then click Next. 

 

7. In the InstallShield Wizard window, click Next. 

 

8. Please click Yes to install SQL Native Client program. 

 

9. In the InstallShield Wizard Complete dialog box, click Finish. 

 

NCS Client 
To install NCS Client (include Matrix): 

1. Insert the NCS installation CD. 
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2. In the Welcome to NCS window, click NCS Client. 

 

3. Complete installation as described in steps 3-7 of the    To install NCS Alarm Server section on page 9. 

 

4.  In the InstallShield Wizard Complete dialog box, click Finish. 

NCS Matrix 
To install NCS Matrix: 

1. Insert the NCS installation CD. 

 

2. In the Welcome to NCS window, click NCS Matrix. 

3. Complete installation as described in steps 3-4 of the  To install NCS Client section on page 11. 
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Uninstalling NCS System 
To uninstall SQL Server: 

In the Control Panel, open Add or Remove Programs, select and click on Remove button to uninstall four SQL objects 
(Microsoft SQL Sever 2005, Native Client, Setup Support Files, VSS Writer). 

 

To uninstall the NCS system: 

In the Start menu, point to All programs, point to NUUO Central Management Server/Client/Matrix, and then click 
Uninstall NCS System. 

 Transfer all license connections and then transfer license base before you uninstall the NCS System. 
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Getting Started with the NCS System 

Main Console Configuration 
To configure the Main Console: 

1. Run MainConsole.exe. 

 

2. In Config, select Network Service, and set up the following services: 

 Live Streaming and Central Management. These services are essential to run the NCS system. Please Start 
these two services. 

 Remote Playback. This service enables recorded video viewing and remote playback. Ensure this service work, 
please also Start Recording Schedule to record video. 

 Remote Desktop. This service enables remote configuration of the main console.  

3. Select Guard. 

 

4. In the Event and Action Configuration window, configure alarm events and insert the action Send to Central 
Server for events that you want to appear on the NCS system. 

5. Click OK to return to the main console. 

6. In the Start Menu, select Start Smart Guard System to start detecting events. 

SQL Server 
To configure SQL Server: 

1. In the Start menu, point to All programs, point to Microsoft SQL Server 2005, point to Configuration Tools, and 
then select SQL Server Configuration Manager. 
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2. In the SQL Server Configuration Manager window, select Protocols for CMALARMLOG, right-click TCP/IP and 
then select Enable to enable TCP/IP protocol. 

 

3. Double-click TCP/IP, then in the TCP/IP Properties window select the IP Addresses tab. 

4. Enter 1433 as the TCP port in IP1, IP2, and IPAll, and then click OK. 

 

5. In the SQL Server Configuration Manager window, select SQL Server 2005 Services, right-click SQL Server 
(CMALARMLOG), and then select Restart. 

6. Ensure that any firewall allows access through port 1433. 

NCS Alarm Server 
To configure NCS Server: 

1. In the Start menu, point to All programs, point to NUUO Central Management Server, and then select NCS Server. 

 

2. In the NCS Server dialog box, click OK. This is only required the first time you start NCS server. 
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3. The configuration of NCS Alarm Server. 

 In the Configuration tab of Central Server window, enter the IP address of the SQL Server, and then enter and 
confirm the password which sat when installed SQL Server. (see page 8) 

 Specify a URL at which to store all alarm images. 

 Select Run NCS Server when Windows starts up if you want NCS Server to startup automatically at Windows 
startup 

4. In the Main table of this window, check the server has been Start and click OK. 

 The NCS Server must be executed before the NCS Client can be executed. 

 

NCS Client 
To configure and execute the NCS Client: 

1. In the Start menu, point to All Programs, point to NUUO Central Management Client, and then select NCS Client. 

 

2. In the Central Login window, enter the IP address and port of the NCS Server PC. The default port is 5180.  

3. Enter a user name and, if required, a password. The default user name is admin and the default password is 
empty. 

4. Click OK. 

To activate software license key(s)   

1. Open License Manager Tool in Help menu. 

2. Select Activate tab, check the NCS system in On line network environment. 

3. Insert the SN, SN file or dongle to activate license. 

4. After software license is activated successfully, please restart NCS Client. 

 Please refer page 46 for advanced settings. 

To start up NCS Client automatically: 

1. In the Edit menu, select NCS Client Setting. 
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2. In the NCS Client Setting window, select Enable Auto Startup and Enable Auto Login 

3. Enter a user account and, if required, a password.  

4. Click OK. 

 

NCS Matrix 
To execute a single matrix display: 

1. In the Start menu, point to All Programs, then point to NUUO Central Management Client or NUUO Central 
Management Matrix, and click NCS Matrix. 

To configure the first matrix in a multiple matrix system: 

2. Ensure that the PC is configured to use multiple monitors. 

3. In the Start menu, point to All Programs, then point to NUUO Central Management Client or NUUO Central 
Management Matrix, and click NCS Matrix. 

 

4. Click on Option to open Matrix Instance Dialog.  

 

5. In the Matrix Instance Option Dialog window, select Default from list table. 

6. Enter a matrix name, for example Monitor 1, in the Instance Name text box, leave the port at the default setting of 
5210, select the #1 monitor from drop-down list, and then click Update to update modification. 

To configure the second and subsequent matrixes in a multiple matrix system: 

1. In the Matrix Instance Option Dialog window, enter a matrix name, for example monitor 2 in the Instance Name 
text box. 

2. Enter port number 5220. 

3. Select the #2 monitor from drop-down list, and then click Update to update modification. 
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4. To configure a third and a fourth monitor, repeat steps 1-3  naming the matrix instances as appropriate (for 
example monitor3, monitor4), entering the port number (5230 for a third monitor and 5240 for a fourth), and 
selecting the appropriate monitor. 

5. Click OK to save all configuration of Matrix. 

To execute a matrix in a multiple matrix system: 

1. Ensure that the matrixes have been configured as described above. 

 

2. In the Matrix Instance Dialog window, choose the matrix you want in the drop-down list, and then click Start to 
start Matrix view. 

3. Repeat steps 1 and 2 to execute each monitor. 
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NCS System Overview 

NCS Server Window Introduction 
The NCS Server features two main windows. The windows are: 

Main window can control all connection situations, include Start/Stop NCS Server, Port, maximum connection of 
Clients, and restrict connection of client by Kill Client option.  

Configuration window has three major options for setup the connection between SQL Server and NCS Server, 
Save/Load or Restore NCS Configuration which set by NCS Client(refer Loading/Saving NCS Client Configuration 
section of page 44), and set basic Options of NCS Server which include storage of save alarm image and run NCS 
Server when Windows startup. 

 

 
Restore NCS Configuration will not clear the setting of SQL Server. 

Also some quick start in Taskbar when running NCS Server, you can see the version or exit the NCS Server by click 

the  icon from Taskbar.  
 

 

NCS Client Window Introduction 
The default NCS Client window placement is as below figure, include three main windows, four toolbars, and six menus. 

 

 
System 
Control 
Window 

Alarm 
Overview 
Window 

Toolbox 
Menus 

 

 

Map Window 
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Three Main Windows are: 

 System Control window: This window includes Server, Config, Matrix, and MapView sub-windows. Administrators 
can configure the NCS system in this window, when the system is in Edit Mode. (See Part 2: Administrator 
Functions (Setting Up the NCS System) 

 

 Map window: This is window shows all maps and device indicators. For setup by administrators, see page 27. For 
day to day use, user can view the video, show device information, query and manage alarms form the indicators 
(please refer page 59). 

 

 Alarm Overview window: The default Alarm Overview window contains the Recent, Real-Time, Output, Output 2, 
and Message Log tabs, which allow users to manage alarms (see page 52). 

 

Six menus are: 

 The File menu: This menu has functions use to commit to NCS Server, save/load NCS Client Configuration, and 
Logout/Exit NCS system. 
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 The Edit menu: It allows administrator add New Object to configuration sub-window of System Control Window, 
Import Indicator Image, setup Server configuration (refer Central Server Configuration Window section of page 37) 
on Edit mode; and allows all user to setup Map Display setting of Map windows, Alarm Log setting of alarm 
overview windows, and setup Joystick to control Matrix. 

 The View menu: This menu has options to setup the appearance of NCS Client window. 

 The Tools menu: This menu has five tools to help user easy to get information for Main Console, manage alarms, 
and view live and record videos. 

 The Zoom menu: User can control and adjust map appearance (see page 59). 

 The Help menu: The menu provides the version information of NUUO NCS Client. 

The toolbars are: 

 The Standard toolbar: The functions accessed by this toolbar are: committing configuration changes to the server 
(see page 23), importing/exporting NCS Client software configuration (see page 45), and displaying version 
information (see page 76). 

 The Zoom toolbar: The functions accessed by this toolbar are the same as Zoom menu, used to adjust map 
appearance (see page 59). 

 The Edit toolbar: The functions accessed by this toolbar are: toggle Edit Mode/Operate Mode (see page 23) and 
rotate indicator on/off (see page see page 29). 

 The Operate toolbar: The functions accessed by this toolbar help users in day to day use of the NCS Client. For 
more information, see page 51. 

 
Standard             Zoom             Edit                                                    Operate  

Customizing Client Appearance 
The appearance of the NCS Client is customizable. The System Control and Alarm Overview windows and their nine 
associated tab display windows can be moved or removed to four appearance types: 

 Floating: A floating window can be moved to any position on the screen.  

 Docking: A docking window is aligned with one of the four edges of the application window. 

 Auto Hide: Docking windows can be set to AutoHide. The window then displays only when you point to the area 
of the screen where the window is docked.  

 Hide: Hide the windows can be removed form screen.  

Toolbars also can be moved or removed. The look of the client can also be changed to various preset styles. 

 
To restore appearance back to default, please go to View menu and click on Reset Window Placement. 

To move a main window: 

Click the title bar at the top of the window and drag it to the position you want. If you want it to dock at one of the edges of the 
NCS Client window, drag it to one of the direction arrow buttons. There are three direction arrow buttons groups of different 
windows (refer next page): 

 The Central group of Map Window, it allow move window to four edge of Map window. 

 The Outside group of NCS Client Window, it allow move window to four edge of Map window. 

 The Attached group of individual window, it allow move window to four edge of individual window and move to be 
an associated tab display windows. 

To move an individual tab display window: 

Right-click on a tab and select Floating, or click directly on the tab and drag the window to the position you want. If you 
want it to dock at one of the edges of the NCS Client window, drag it to one of the blue direction arrow buttons. The Auto 
Hide function can now be applied to that tab window individually. 
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To move an individual tab display window to a main window: 

Right-click on a tab and select Docking, or click directly on the tab and drag it to a tab bar in a main window. 

 

Outside Group 

Central Group Attached Group 

 
These direction arrow buttons groups only appear  when NCS Client preset style set as Office 2003 / Visual 
Studio.NET 2005 /  Office 2007   

To Auto Hide a window (only available when window is docked): 

Either: 

 Right-click in the window and select Auto Hide. 

Or: 

 In the title bar for the window, click the Auto Hide toggle button . 
 

 
The Auto Hide function applies to all tab windows in a main window. If one of the tab windows in a main 
window is set to Auto Hide, all the other tabs will also Auto Hide. 

To close an individual tab display window: 

Right-click on a tab and select Hide or click directly on the Close Window button  on the top right corner of the window. 
To display the window again, go to the View menu, point to Toolbars, and then check the window you want to show. 

 
Another way to close a window is to uncheck a box in the Toolbars menu. 

To move a toolbar: 

Click on the double line on the left side of a toolbar  and drag it to the position you want.  

To hide or display a toolbar 

Go to the View menu, point to Toolbars, and then uncheck or check the toolbar you want to hide or show. And if user drag 
to as an individual menu in window, simply click the  button on the top right corner of the menu to close it. 

To change the look of the NCS Client to a preset style: 

In the View menu, point to Application Look, and choose one of the following preset application looks: Office 2000 / Office 
XP / Office 2003 / Visual Studio.NET 2005 / Windows XP / Office 2007 
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System Operate Mode/Edit Mode 

 
To carry out most administrator functions, you need to be in Edit Mode. 

 
Press the Edit Mode toggle button  to enter Edit Mode, and press it again to exit Edit Mode. When in Edit 

Mode, the NCS Client will not receive alarms. A flashing indicator  reminds you that you are in Edit Mode. 

 

Any changes made to the system must be saved with the Commit  button. When administrators 
click the Commit button to save changes, other users will be disconnected from the NCS server and will 
need to log in again. 

NCS Matrix Window Introduction 
Move Mouse to right-down area, the                         icon would auto appear. User can edit/exit the Matrix, further option 
please see page 42.  

SQL Server Introduction 
NCS system is use SQL Server 2005 Express of Microsoft free application software as database. NUUO recommend user 
to use Microsoft SQL Server Management Studio Express to backup SQL Server. Please refer the web site of Microsoft 
http://technet.microsoft.com/en-us/library/ms365247.aspx . 
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Part 2: Administrator Functions (Setting Up the NCS 
System) 

This section describes functions and operations of the administrator to set up the NCS Client software system while in Edit 
Mode. Please follow this section to setup Servers/Devices, Maps, Servers/Devices on Map, User Groups and Users, 
Coverage, Alarms, and Matrix system. 
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Servers/Devices 

The NCS Client provides the ability to monitor unlimited cameras and input/output devices through unlimited Main Console 
servers. For convenience, Main Console servers and their related devices are organized into groups. The default top-level 
group is called ServerGroup. Child groups can be added to this in a hierarchical structure. 

 
To carry out the functions described below, you need to be in Edit mode and Commit after setup (see 
page 23). 

 

The license of the software should be registered first before operating the formal version of NCS System.  

Execute the License Management Tool in Help>License Manager to activate the license from a dongle or serial 
number allocated with the NCS software package, or de-activate the license then use it on another PC to activate it 
again. 

Note: Please refer page 46  for how to configure the License Management Tool. 

 

Adding/Editing/Removing Server Groups 
To add a server group: 

1. Ensure that the client is in Edit Mode and that the ServerView tab is selected. 

2. Right-click on the ServerGroup icon  at the top of the window, then click Add Group. 

3. Enter the group name, then click OK. 

4. The group you added appears in the tree structure of the ServerView window. 

To edit a server group name: 

1. Right-click on the server group icon  for the group you want to edit. 

2. Select Settings. 

3. Enter the name you want, then click OK. 

To remove a server group: 

1. Right-click on the server group icon  for the server group you want to remove. 

2. Select Delete and click Yes at the confirmation prompt. 

Adding/Editing/Removing Servers 
Servers can be added to any server group. When a server is added, the devices on it must be synchronized with the NCS 
Client (See page 26). This procedure ensures that the cameras, input/output devices, and POS (Point of Sale) on the 
server are available for monitoring. 

To add a server: 

1. Ensure that the client is in Edit Mode and that the ServerView tab is selected. 

2. Right-click on a server group icon , then click Add Server. 

3. Enter the server details, then click OK. The Central Management Port should be the same as setup in Main 
Console server. 
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Licenses for all servers and devices (cameras, I/O device and POS) need to be activated via NCS Client. 
(See Page 47) 

 
If you enter the Central Management port and click Detect, the NCS system will auto-detect the ports for 
Live Streaming, Remote Playback and Remote Desktop. 

 
Click the Server Info button to open a Server Information window, and the Server Information will 
be displayed on the Alarm detail window when an alarm is active. 

 

4. The server you added appears in the tree structure of the ServerView window. 

To synchronize server devices: 

Right-click on a server icon , then click Synchronize Device. Then, all cameras, POS and input/output devices of Main 
Console server will appear and be available for monitoring. 

 

You must have enough licenses for the devices, otherwise the devices without licenses will show disable 

icon . In the Tool menu, select Server Summary to check the license status. 

To edit server settings: 

1. Right-click on a server icon , then click Settings. 

2. Enter the required settings, then click OK. 

To remove a server: 

1. Right-click on a server icon . 

2. Select Delete and click Yes at the confirmation prompt. 
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Maps 

The Map window displays indicator icons representing the devices and servers that the NCS client monitors. They are 
shown against map backgrounds. This enables quick and easy control and monitoring of devices according to their location. 
Multiple maps of different locations and at different scales can be used, as described below. To change the size, pan 
settings and brightness of map graphics, see page 59. 

 
To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see 
page 23). 

 

Map Hierarchy 
Maps can be layered in a hierarchical structure. Typically, the top–level (parent) map is at a large enough scale to cover the 
geographical areas of all the lower-level (child) maps. Each child map is assigned an icon on the parent map. Clicking a 
child map icon shows the child map in the Map window. Multiple levels of child maps can be defined. 

 

 
The default top level map is provided by NUUO. To change this, see the section To edit map settings 
below. 

 

Adding/Editing/Removing Maps 
To add a child map to a parent map: 

1. Ensure that the client is in Edit Mode and that the MapView window is selected. 

2. Right-click on the icon for the parent map , then click Add Map. 

3. Enter the required details. 

4. If you do not want to use the default indicator image, please manual import another image and set to default (For 
information on importing indicator images, see page 28.). 

5. Click OK. The map you added appears in the tree structure of the MapView window. 

6. The map indicator appears on the parent map. Drag it to the position you want. 

To edit map settings: 

1. Right-click on a map icon , then click Settings. 

2. Enter the required settings, then click OK. 

To remove a map: 

1. Right-click on a map icon . 

2. Select Delete and click Yes at the confirmation prompt. 
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Servers/Devices on Map 

Each Main Console server or device can be assigned to a map. An indicator for the Main Console server or device is 
displayed on the map at the position you choose. This allows quick and easy control and monitoring. You can control the 
orientation of indicators as well as the appearance of accompanying text and the information it shows. The NCS Client 
software comes with default indicator images, but you can also import your own. 

 
To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see 
page 23). 

 

Importing Indicator Images 
To import an indicator image: 

1. In the Edit menu, select Import Indicator Image. 

2. From the drop-down list, select the type of indicator image you want to import. 

 

3. Click Import, browse to the required image file, and open it. 

4. Click OK. 
 

 
If you want to set a specific image as the default for a file type, select the image, then select the Default 
checkbox. 

 

Adding/Removing Device Indicators 
There are two ways to add device indicators to a map: MapView display and ServerView. 

To add device indicators to a map in MapView: 

1. Ensure that the client is in Edit Mode and that the MapView window is selected. 

2. Click on the map icon  for the map you want to add an image to. This displays the map. 

3. Right-click on the map icon. 

4. Click Add Server Indicator, Add Camera Indicator, Add POS Indicator or Add I/O Indicator, as required. 

5. From the drop-down list, select a device. 

 

6
5
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6. Choose an indicator. 

 

7

7. When the device is a camera select Show Coverage Area to set the Range and Radian. 

8. Click OK. 

9. The device indicator will appear on the map. Drag it to the required location. 

To drag a device indicator to a map from ServerView: 

1. Ensure that the map you want is displayed. 

2. Click on the ServerView window. 

3. Directly drag a device to the desired location on the map. 
 

 
If you are in MapView and click on a device which has already been added to a map, the map for that 
device will be displayed. 

 

To remove a device indicator from a map: 

1. Right-click the indicator. 

2. Click Delete. 

3. Click Yes in the confirmation window. 

Edit Device Indicators 
An indicator image can be rotated, mirrored, or changed. The image can also be set to refer to a different device than the 
one originally chosen. 

To rotate a device indicator to a preset angle: 

Once a device indicator has been added or dragged to a map, the indicator image can be rotated. This is useful to show 
which direction a camera is pointing. 

 
1. Right-click the indicator or right-click the device from MapView. 

2. Click Rotate and choose an angle (preset angle 0, 45, 90, 135, 180, 225, 270, or 315 degrees).  

 
The radian, range, color and area of Camera Indicator can be set to show camera coverage.  

 

To rotate a device indicator to an arbitrary angle: 

1. Right-click the indicator or right-click the device form MapView, or click  icon from Edit toolbar. 
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2. Click Rotate Arbitrary. 

3. Use the rotation handle to rotate the indicator to the desired angle, then click to fix the angle. 

4. Click Rotate Arbitrary again to close this option. 

To mirror a device indicator: 

Indicator images can be mirrored (flipped horizontally) so that a mirror image is displayed. One use would be to show in 
which direction a camera is pointing. For example, a default image may show a camera pointing left. 

1. Right-click the indicator or right-click the device form MapView. 

2. Click Mirror. 

3. Mirroring would then have it facing right. 

       
 

 
The mirror command is a toggle. To un-mirror a previously mirrored indicator, follow steps 1 and 2 again. 

 

To change a device indicator image: 

1. Right-click the indicator or right-click the device form MapView. 

2. Click Settings. 

3. Select the indicator image you want, then click OK. 
 

 
To import a new indicator image, see page 28. 

 

To remove a device indicator from a map: 

1. Right-click the indicator or right-click the device form MapView. 

2. Click Delete. 

3. Click Yes in the confirmation window. 
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Coverage 
Coverage is a defined period or periods of time. This is used for the following purposes: 

 To define the times a user can log in to the system and use the NCS client. This coverage is applied according to 
the local time of the NCS Client. 

 To define the times that an alarm is active. This coverage is applied according to the local time of the source Main 
Console server. 

 
To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see 
page 23). 

 

Adding/Editing/Removing Coverage 
To add a coverage: 

1. Ensure that the client is in Edit Mode and the Configuration window is selected. 

2. Right-click on the Coverage folder icon , then click Add Coverage.  

 

3. In the Coverage Dialog window, enter a coverage name and, if you want, a coverage description. 

4. Choose a coverage mode: 

 General is for regular coverage periods. 

 Specific Day means that this coverage applies to a specific date only. Choose the date from the drop-down list. 

5. Select the time periods you want for this coverage. 

 Drag over the time periods you want. Selected periods appear in blue.  

 To remove periods, select Remove Time Period and drag over the periods you want to remove. 

 To clear all selected periods, click the Clear All button. 

6. Click OK. The coverage you added appears in the tree structure of the Configuration window. 
 

 
You can also add a coverage from the Edit menu by pointing to New Object, clicking on Coverage then 
following steps 3 – 6 above. 

 

To edit a coverage: 

1. Right-click on the coverage icon  for the coverage you want to edit. 

2. Select Edit Coverage. 

3. Edit the settings as required. 

4. Click OK. 

To remove a coverage: 

1. Right-click on the coverage icon  for the coverage you want to remove. 

2. Select Delete Coverage and click Yes at the confirmation prompt. 
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User Groups and Users 

System administrators can control who can use the NCS client, when they use it, their ability to perform various functions, 
and which devices they can access. Privileges are assigned via user groups. For each user group, an administrator can 
define permitted functions as well as which devices the users in that group can access. Password control, permitted access 
times (see page 31), and a matrix profile (see page 40) are configured in the settings for each user. 

 
To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see 
page 23). 

 

Adding/Editing/Removing User Groups 
To add a user group: 

1. Ensure that the client is in Edit Mode and that the Configuration window is selected. 

2. Right-click on the UserGroup folder icon , then click Add User Group. 

           

3. In the User Group Configuration window, enter a group name and, if you want, a group description. 

4. In the Function Privilege area, select the privileges for members of this UserGroup: 

 Alarm Management – allows users to change alarm status on the Alarm Detail window (see page 52). 

 

Alarm Management 

Alarm Image 

 View Alarm Image – allows users to see a snapshot from the camera as an icon in the Recent display (see 
page 52) and view snapshot on Alarm detail Window. 
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 Open Live Video – allows users to open a live video window to view image of the camera and related devices 
from the Alarm Detail window or by right-clicking on a camera indicator. 

 Open/Backup Recorded Video – allows users to open or back up recorded video of the camera and related 
devices from the Alarm Detail Window or by right-clicking on a camera indicator. 

 PTZ Control – allows users to control the PTZ (pan, tilt, zoom) settings of compatible cameras. This option only 
works when users have Open Live Video authority simultaneously. 

 Control Digital Output – allows users to control digital outputs such as alarms. This option only works when 
setting IO devices as related devices in Alarm setting (see page 35 ). 

 View and Search POS transaction – allows users with authorization to search POS transactions.  

 Remote Desktop – allows users to open a remote desktop. 

5. In the Device Access area, choose the devices which members of this UserGroup will be able to access. If the 
devices have not been enabled in Device Access table, users still don’t have allow to use above functions.  

6. Click OK. The user group you added appears in the tree structure of the Configuration window. 

 
You can also add a user group from the Edit menu by pointing to New Object, clicking on User Group 
then following steps 4 – 6 above. 

 
For quick add a new UserGroup, please use Insert Copy option by right-click on the UserGroup which you 
want to copy.  

 

To edit a user group: 

1. Right-click on the UserGroup icon  for the user group you want to edit. 

2. Select Edit User Group. 

3. Edit the settings as required. 

4. Click OK. 

To remove a user group: 

1. Right-click on the UserGroup icon  for the user group you want to remove. 

2. Select Delete Group and click Yes at the confirmation prompt. 

Adding/Editing/Removing Users 
To add a user: 

1. Ensure that the client is in Edit Mode and the Configuration window is selected. 

2. Right-click on the User folder icon , then click Add User. The User Configuration window appears. 

 

3. In the User Configuration window, enter a user name. 

4. If password access is required for this user, enter and confirm a password. 

5. If you want, enter a description. 
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6. If you want this user to receive auto alarm notifications by email or SMS, enter the email address and/or Cellphone 
number. 

7. Choose a user group, a coverage (see page 31), and a matrix profile (see page 40) from the drop-down lists. The 
coverage here is based on the NCS Client’s local time. 

8. Click OK. The user you added appears in the tree structure of the Configuration window. 
 

 
You can also add a user from the Edit menu by pointing to New Object, clicking on User then following 
steps 3 – 8 above. 

 

To edit a user: 

1. Right-click on the user icon  for the user you want to edit. 

2. Select Edit User. 

3. Edit the settings as required. 

4. Click OK. 

To remove a user: 

1. Right-click on the user icon  for the user you want to remove. 

2. Select Delete User and click Yes at the confirmation prompt. 

 
Enable Disable User Account option on User Configuration window also can reject this user account to 
login NCS system. 
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Alarms 

The alarm functions of the NCS Client can be configured to monitor many different events triggered by cameras, input 
devices, output devices, and servers. 

 
To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see 
page 23). 

 

Adding/Copying/Editing/Removing Alarms 
To add an alarm: 

1. Ensure that the client is in Edit Mode and the Configuration window is selected. 

2. Right-click on the Alarm folder icon , then click Add Alarm.  

 
3. In the Alarm Configuration window, enter an alarm name and, if you want, an alarm description. 

4. Choose an alarm priority and an alarm owner from the drop-down lists. 

5. Choose from the following settings: 

 Choose a coverage (default coverage is Always). The coverage here is based on the alarm source device’s local 
time. 

 Enter a rearm interval. If the rearm interval is too short (default interval is 5 sec.), multiple alarms may be 
triggered by certain events such as motion. 

 If you want the alarm to close automatically when the triggering event ends, check Auto Close Alarm. 

 If you do not want to put the alarm into effect straight away, check Disable Alarm. 

 If you want, click Alarm Management Guide and enter text. This text appears in the alarm detail window (see 
page 55). The text also appears when users point to a device for which the alarm is active. 

6. Select options in the Auto Notify (NCS Client) area: 

 If you want the map window to automatically display the map for the alarm’s source device, select Go to Map 

Layer. User can click on  icon to stop this function when day to day use. 

 For a camera alarm event, if you want a live video window from that camera to pop up, select Popup Live Video 

Window. Up to three live video windows can be open at a time. User can click on  icon to stop this function 
when day to day use. 
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 If you do not want to send the video of an alarm source camera and a related camera to matrixes, check Disable 

to Matrix button .  

 If you do not want alarm events to replace old events on the Matrix if the Matrix is full and users do not close old 

events, check the Disable Matrix Popup button .   

 
NCS system will auto filter the same alarm of one camera, it can’t allow one alarm of a camera to use 
more than one popup live video windows. 

 If you want a sound to play when the alarm is triggered, check the Play Sound box, then click the URL button 

 and browse to a sound file. 

 For a camera alarm event, if you want the camera’s video feed automatically sent to a matrix, choose a matrix 
from the Send to Matrix drop-down list. If a related camera is selected, you can also choose to Show Related 
Camera to Matrix by checking that box. 

 

 

The options of this section, Go to Map Layer, Popup Live Video Window, Play Sound, Send to Matrix, 
and Show Related Camera on Matrix settings apply only to one computer. If users run the NCS Client on 
another computer, they will have to configure the settings for that computer. To use Send to Matrix and 
Show Related Camera on Matrix, a matrix must be configured (see page 38), and that matrix must be set 
to Allow Show Video on Event (see page 71). 

 
7. Select options in the Auto Notify (NCS Server) area: 

 If you want the server to send an automatic email to users when an alarm event happens, click the Email button 
and then select users. 

 If you want the server to send an automatic SMS message to users when an alarm event happens, click the 
SMS button. The text of the message is [Alarm Name] on [Date/Time]. 

 

 
To configure the server’s GSM modem and email settings (including email content), see page 37. 

 
8. In the Source Device area, select the device/s which will trigger this alarm. 

9. In the Event Message area, select the event/s which will trigger this alarm. 

10. In the Related Device area, select devices which you want to relate to this alarm. For example, an input device 
event can automatically trigger a live video popup from a related camera. 

11. Click OK. The alarm you added appears in the tree structure of the Configuration window. 
 

 
You can also add an alarm from the Edit menu by pointing to New Object, clicking on Alarm then 
following steps 3 – 11 above. 

 

To copy an alarm: 

1. Right-click on the icon  for the alarm you want to copy. 

2. Select Insert Copy. 

3. Configure the alarm as described above. 

4. Click OK. The alarm you added appears in the tree structure of the Configuration window. 

To edit an alarm: 

1. Right-click on the icon  for the alarm you want to edit. 

2. Select Edit Alarm. 

3. Edit the settings as required. 

4. Click OK. 
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To remove an alarm: 

1. Right-click on the icon  for the alarm you want to remove. 

2. Select Delete Alarm and click Yes at the confirmation prompt. 

Central Server Configuration Window 
The Central Server Configuration window controls how the server keeps alarm records, and also GSM and E-Mail server 
settings for auto notification of alarms to users. 

 
If necessary, see your IT administrator for details on these settings. 

 

To configure server alarm records: 

1. In the Edit menu, click Server Configuration. 

2. In the Alarms Settings area of the Central Server Configuration window, enter the number of days to keep 
closed alarms and all other alarms. 

 
The default period of Keep Closed Alarms is 3 days, the NCS system would remove all closed alarm 
happened three days ago at 12:00 PM everyday. 

 
The default period of Keep All Other Alarms is 30 days, the NCS system would remove all closed alarm 
happened thirty days ago at 12:00 PM everyday. 

To configure system auto notification via SMS: 

1. In the Edit menu, click Server Configuration. 

2. In the GSM Settings area of the Central Server Configuration window, select a port and a baud rate from the 
drop-down lists. 

3. Enter a PIN code if required. 

4. If you want to send a test message, enter the destination phone number and click Send Test Message. 

 
NCS system will auto filter the SMS for the same alarm, one alarm can’t trigger another SMS before one 
SMS send out. 

To configure system auto notification via email: 

1. In the Edit menu, click Server Configuration. 

2. In the E-Mail area of the Central Server Configuration window, enter an SMTP server, port and select Secure 
connection (SSL)  

3. Enter an email sender, an email subject, and the body content of the email. 

4. If the SMTP server requires authentication, check the box and enter the user account name and password. 

5. If you want, click Send Test Mail. 
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Matrix System 

The NCS Client provides feeds over the Internet to multiple video matrixes. Each matrix can display images from up to 64 
cameras, along with text above each image including information about the camera and server. 

 
To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see 
page 23). 

 

Adding/Editing/Removing Matrixes 
To add a matrix: 

1. Ensure that the NCS Matrix system is running, either on the same computer as the NCS Client, or on another 
computer. 

2. Ensure that the client is in Edit Mode and the Configuration window is selected. 

3. Right-click on the Matrix folder icon , then click Add Matrix.  

   

4. Under General in the Matrix Setting window, enter a matrix name and an IP address. 

 To enter a port. This port must be the one configured for the matrix itself. For multiple matrix systems, enter the 
same IP, and the port for each matrix as described on page 39. 

 To test the matrix server, click Test Matrix. 

 To fix the screen aspect at 4:3, check the box. 

 To choose the rate at which camera images are updated on the matrix, enter an auto scan interval. 

5. Under OSD in the Matrix Setting window 

 For text displayed on the matrix, select a font, a font size, and font styles. 

 Choose what information is included in on-matrix text, by checking Info: Server Name, Camera Name, and 
Camera Type boxes as required. 

6. Under POS in the Matrix Setting window 

 Select  enable or disable POS overlay 

 For POS information displayed on the matrix, select a font, a font size, and font color. 

 
 

 
You can also add a matrix from the Edit menu by pointing to New Object, clicking on Matrix then following 
steps 4–7 above. 
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To edit a matrix: 

1. Right-click on the icon  for the matrix you want to edit. 

2. Select Edit Matrix. 

3. Edit the settings as required. 

4. Click OK. 

To remove a matrix: 

1. Right-click on the icon  for the matrix you want to remove. 

2. Select Delete Matrix and click yes at the confirmation prompt. 

To configure the NCS Client for a multiple matrix system: 

Follow steps 1-7 of the procedure described above, entering the matrix name and port as appropriate for each matrix. 
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Loading/Saving/Managing Matrix Profiles 

A matrix profile stores the matrix grids, stream profile and camera positions for one or more matrixes. (For information on 
configuring matrix grids and camera positions, see page 71). All users can load matrix profiles, but only administrators can 
save and edit them. 

To load a matrix profile: 

Click the Profile button  and point to Load Profile, then click the profile you want to load. 

To save a matrix profile: 

1. Click the Profile button , then click Save Profile. 

 

2. In the Matrix Profile window, enter a name, then click OK. 

 
The setup of Matrix, please see page 71. 

To assign users to a matrix profile from the Matrix Profile Management window: 

1. Click the Profile button , then click Profile Management. 

 

2. In the Matrix Profile Management window, select the profile you want to assign users to, then click Select Users. 

 

3. In the Select User window, check the boxes for the users you want, then click OK. 

4. In the Matrix Profile Management window, click OK, then click the Commit button  to save your 
changes to the server. 

 

 
You can also assign a user to a matrix profile in the User Configuration window (see page 33). 
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To rename a matrix profile: 

1. Click the Profile button , then click Profile Management. 

2. In the Matrix Profile Management window, select the profile you want to rename. 

3. In the Profile Name box, enter the new name. 

4. Click Update, then click OK. 

5. In the Matrix Profile Management window, click OK, then click the Commit button  to save your 
changes to the server. 

To remove a matrix profile: 

1. Click the Profile button , then click Profile Management. 

2. In the Matrix Profile Management window, select the profile you want to remove. 

3. Click Delete, then click OK. 

4. Click the Commit button  to save your changes to the server. 
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Network Management 

NCS Server Management 
On the NCS Server Window, administrators can Kill Client, change port of connect, and limit the maximum client connections. 

To kill a connected client: 

1. Double click on the NCS Server  icon to open the NCS Server Window. 

2. Choose a client IP and click Kill Client. 

To change connect port and maximum connections:  

1. Click Stop to cut all connections. 

2. Change port of connection and maximum connections. 

3. Click on Start to allow connections. 

  

To change the NCS Server password:  

The default password of admin account is empty. Modify the password from the client software and commit it to the server 
as follows: 

1. Open NCS Client Software and log in with the admin account. 

2. In Edit Mode, select the Configuration Window.  

3. Right-click on the user icon  for the admin account and select Edit User.  

4. Enter a new password, and then click OK. 

5. Click on the Commit button  to commit the modification to the server. 

Matrix Management 
To edit the Allow Hosts list: 

1. In the Start menu, point to All Programs, point to NUUO Central Management Client, and then select NCS 
Matrix to start the matrix. 

2. Point to the bottom-right corner of the screen, and then click on the General Setting icon . 

3. Click OK to open the Matrix Configuration window.  
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4. Click the Allow List button. 

 

5. In the Allow Hosts List window, deselect Allow All Hosts, and then choose from the following actions: 

 To add a host, enter the host IP address, and then click Add.  

 To remove an IP address from the allow list, choose the IP from the table and then click Delete. 

6. Click OK to save the configuration. 

To set a matrix password: 

1. In the Start menu, point to All Programs, point to NUUO Central Management Client, and then select NCS 
Matrix to start the matrix. 

2. Point to the bottom-right corner of the screen, click on the General Setting icon , and then click OK.  

 

3. In the Matrix Configuration window, enter and confirm the password. 

4. Click OK. 

To start up NCS Matrix automatically: 

1. In the Start menu, point to All Programs, point to NUUO Central Management Client, and then select NCS Matrix 
to start the matrix. 

2. Point to the bottom-right corner of the screen, and then click on the General Setting icon . 

3. Click OK to open the Matrix Configuration window. 

 

4. In the Matrix Configuration window, select Run Matrix when Windows startup 

5. Click OK. 
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Loading/Saving NCS Client Configuration 
The NCS Client configuration can be saved to the local PC and loaded back again. The configuration includes: 

 Map display settings 

 Alarm log Settings 

 Matrix Settings 

 MatrixView configuration 

To save or load other settings such as server settings or map settings, see Loading/Saving NCS Server Configuration 
on page 45. 

To load or save NCS Client configuration: 

 

In the File menu, select Load Configuration or Save Configuration. 
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Loading/Saving NCS Server Configuration 

The NCS Server configuration can be saved to the NCS Server PC and loaded back again. It can also be reset to default 
status. The configuration includes: 

 Server settings 

 Map settings 

 Device settings on maps 

 User group settings 

 User settings 

 Alarm settings 

 Coverage settings 

 Indication import settings 

 Server configuration 

 Address and password of SQL Server 

To save, load, or reset NCS Server configuration: 

1. Click the  icon from Taskbar and enter the password. 

 

2. In the Central Server window, click Save, Load, or Reset NCS Configuration. 

 
Restore NCS Configuration will not clear the setting of SQL Server. 
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License Management Tool 
The license of the software should be registered first when upgrading to NCS V1.3.0. 

 

Execute the License Management Tool to activate the license from a dongle or serial number allocated with the software 
package, or de-activate the license and then use it on another PC to activate it again. 

 

Both “On line” and “Off line” status of PC environment could execute the tool to “activate” or “transfer” the license. Below list 
5 types of license management process: 

 To “activate” the license with an NCS System connected to the network, follow the   “Activation On line” process. 

 To “activate” the license with an NCS System not connected to the network, follow the “Activation Off line” 
process. 

 To “activate” the license from a dongle either with an NCS System connected or not connected to the network, 
follow the “Activation from dongle” process. 

 To “de-activate/transfer” the license with an NCS System connected to the network, follow the “Transfer On line” 
process. 

 To “de-activate/transfer” the license with an NCS System not connected to the network, follow the “Transfer Off 
line” process. 

Please refer to the chapter below for detailed steps of each process. 

 

License Management Tool Overview 
Execute License Management Tool 

1. Execute License Manager Tool in Help of NCS Client. 

 
 

2.  The License Management Tool will appear. Please refer to the tool overview below. 

License Management Tool Overview 

Activate 
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Transfer 

 
 

Activate/Transfer License 
Activate License 

 
Activation Online 
 
1. Open License Manager Tool. 

2. Select On line as Activate type. 

3.  Input the SN (Serial number) or Import SN file, and then click on the Activate button. 

 

 

 

 

 

 

 

SN status 

Activate type 

SN type 

SN status 

Transfer type 

Transfer tab 

Activate tab 

 

Activate 

Transfer 

 
4. Restart NCS-Client if activated successfully. 

 
Activation Off line 
 
1. Open License Manager Tool. 

2.  Select Off line as Activate type. 
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3.  Input the SN, and then click on Activate button. 

 
4.  Save Request file, and then take it to another PC connected to Internet. 

 

 

 
5.  Execute OffLineTool.exe on another PC, and then click Activate to send request file to license server. 

 
 
6. Save License file, and then take it to the original NCS Client of the NCS System. 

7. Open License Manager Tool from NCS Client again, select Import license file, and then click Activate button to 
activate. 

 
 

8.  Restart NCS-Client if activated successfully. 

 

Transfer License 

 
Transfer On line 
 
1. Open License Manager Tool. 

2. Select Transfer Tab, and then check On line as Transfer type. 

3. Select SN and click on Transfer button. 

 

 

 
4.  Restart NCS-Client if activated successfully. 

 
Transfer Off line 
 
1. Open License Manager Tool. 
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2. Select Transfer Tab, and then check Off line as Transfer type. 

3. Select SN, and then click Transfer button to transfer SN. 

 

 

 
4. Save Request file. Restart NCS-Client if activated successfully. 

 
5.  Copy request file to another PC connected to internet.  

6. Execute OffLineTool.exe on another PC, check Transfer SN and click Transfer to send request file to license 
server. 

7.  Check Transfer Completed. 

 

 
User must copy the request file to another PC and send it to the license server, otherwise the SN cannot be reactivated!! 

 
NCS Server cannot connect to SQL Server without NCS Base License. 
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Part 3: User Functions (Day to Day Use) 

This section describes function and operations of the client in day to day use, including alarm management and view live 
video on NCS Matrix. 

 

The commands which a user can access are governed by the user group privileges assigned by the 
administrator. For this reason, some of the commands described in the section may not be available to 
each user. 
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Operate Toolbar 

The Operate toolbar controls common functions connected with map view and display, map device searching, and control 
of actions triggered by alarms.  

 

It has seven controls and three tools: 

 The Go to Parent Map button , which shows the parent map in the Map window. 

 The Disable Goto Map button . When selected, alarm events cannot change the map view. 

 The Disable Popup button . When selected, alarm events cannot trigger a live video popup. 

 The Disable Link between Map and Matrix button . When selected, links between Map and Matrix View 
devices cannot be displayed on the NCS Client. 

 
If users enable Link between Map and Matrix, selected cameras on the map can be highlighted on the 
Matrix View and vice versa. 

 

 The Disable to Matrix button . When selected, alarm events cannot send alarm source camera and related 
camera video feed to matrixes. 

 The Disable Matrix Popup button . When selected, video of new alarm events cannot replace old events on 
the Matrix if the Matrix is full and users do not close old events.  

 The Close Sound button . When selected, alarm events cannot trigger a sound. 

 The Search button , which opens the Search window, to search devices on the map. 

 The Search text entry box , which enables quick search of devices on the map. 

 The Brightness slider , which controls the brightness of the map. 
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Alarm Overview Window 

The Alarm Overview window shows recent alarm events in various formats, and is also used to show alarm query results 
and log messages. For any alarm displayed in this window, an Alarm Detail window can be opened. This enables easy 
management of alarms. There are five tabs in the window: Recent, Real Time, Message Log, Output and Output2. The 
first three tabs show recent real-time alarm information, and the remaining two tabs show query and search results. The 
function and use of these tabs is described below. 

Recent Tab 

 

The Recent tab gives a display of recent alarm events in icon format. When the alarm event is triggered by a camera, the 
icon normally shows a snapshot of the video feed from that camera at the time the alarm was triggered. However, when the 
camera signal is lost or the user does not have authority to view snapshots from that camera, or when the event is triggered 
by another device, other icons are displayed. The various icons and their meanings are shown below. 

 

 

Event Message Snapshot for Camera Events, including General Motion, 
Foreign Object, Missing Object, Focus Loss, Camera Occlusion  

 

Event Message Picture for Camera Event of Signal Lost. 

 

Event Message Picture for I/O Event of Digital Input Triggered. 

 

Event Message Picture for POS Event without an associated camera or no 
authorization to view video.

 

Event Message Picture for Server System Abnormal Events, including Disk 
Space Exhausted, System Health Unusual and Source Server Disconnect. 

 

Event Message Picture for Server System Operational Events, including 
Start/Modify/Stop Smart Guard, Schedule, Live Streaming Server, Remote 
Playback Server, Start/Stop Manual Record, Modify Confiquration, 
Enable/Disable Channels, Lock/Unlock System.  

 

Event Message Picture for Device Authority Deficiency; The user does not 
have the authority to view the snapshot of that device. 

To control the number and size of icons, see page 55. 
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Real-Time Tab 

 

Click on tab to 
filter alarms. 

The Real-Time tab gives a list of alarm events as they come in to the client. For client configurations where a lot of devices 
are being monitored, a great many alarm events may be received. To display only relevant events the user can filter by 
Priority, State, Alarm Name, Event Type, Source Server, Source Device, Owner, and Time. In addition, the number of 
displayed alarm events can be controlled (see page 55). 

To filter by priority: 

Click the Priority button. From the list, select the priorities for alarms you want to display. 

To filter by state: 

Click the State button. From the list, select the states for alarms you want to display. 

To filter by alarm name: 

1. Click the Alarm Name button. 

 

2. In the Alarm Name Filter window, select the alarm names for the alarms you want to display. 

To filter by event type: 

1. Click the Event Type button.  

 

2. In the Event Type Filter window, select the alarm names for the alarms you want to display. 

To filter by source server or source device: 

1. Click either the Source Server or the Source Device button.  
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2. In the Source Server and Source Device Filter window, select the server/s, the camera/s, I/O device/s or POS/s 
for the alarms you want to display. 

To filter by alarm owner: 

1. Click the Owner button.  

 

2. In the Select User window, select the owners for the alarms you want to display. 

To filter by time: 

Click the Time button. From the list, select the period (1 Hour, 1 Day, 1 Week, or 1 Month) for alarms you want 
to display. 

 
The above filter options can also be accessed by going to the Tools menu, pointing to Real-Time Filter, 
and clicking on the filter option you want. 

 

Output Tab and Output 2 Tab 
The Output and Output 2 tabs show lists of alarm event query results (see page 63) or alarm event search results from the 
Advance Alarm Search tool (see page 69). The lists can be ordered according to Priority, State, Alarm Name, Event 
Type, Source Server, Source Device, Description, Owner, or Time. 

 

Click on tab to 
order lists. 

To order lists in Output and Output 2 tabs: 

Click the button at the top of the column you want to order by. For example, if you want to order by time, click the Time 
button. To reverse the order, click the button again. 

Message Log Tab 
This tab displays messages from the server. The displayed messages are as follows: 
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 NCS server failed to execute SQL command 

ideo on matrix [matrix name] 

eal-Time displays. It also includes the option to 
ain Console server for alarm events. 

To c

1. In the Edit menu, click Alarm Log Setting. 

 The disk space of NCS server is low 

 The license of NCS server is missing 

 Failed to connect to matrix [matrix name] 

 Failed to connect live v

Alarm Log Settings 
The Alarm Log Setting window features controls for the Recent and the R
display the local time of the source M

onfigure alarm log settings: 

 

2

  range 0 to 99. This controls how many icons can be 

 s viewed 

 0 to 999. This controls how many alarm events 

 ant to view alarm event times in the local time at the source server, check Show Source Server Local 

 signal), and to print alarm 
e, priority, and owner of the alarm. 

Right-click on any alarm event in the Alarm Overview window, and then click Alarm Detail. 

. In the Alarm Log Setting window, configure the following options: 

In the Recent Alarm area, enter a display count in the
viewed at one time when the Recent tab is selected. 

In the Recent Alarm area, select the Image Size from drop-down list. This controls the size of icon
when the Recent tab is selected. There are four image size, 80x60,160x120, 240x180, 320x240. 

In the Real-Time Alarm area, enter a display count in the range 
can be viewed at one time when the Real-Time tab is selected. 

If you w
Time. 

3. Click OK. 

Alarm Detail Window and Alarm Management 
For any alarm displayed in the Alarm Overview window, an Alarm Detail window can be opened. This gives detailed 
information about the alarm. Depending on the privileges assigned to users, it can also include basic information options to 
view live or recorded video feeds, to trigger digital output devices (for example an audible alarm
details; and alarm management tools to set or reset the stat

To view alarm information in the Alarm Detail window: 

 Page - 55  



NUUO Central Management System 
Alarm Overview Window 

 

The Alarm Detail window gives details of four sections: 

 Basic information: Include Alarm Name; Source Server; Source Device; Event Type; Date /Time (client local 
time in the first line, and source server local time of Main Console in the second line) 

 Alarm Image: The snapshot or icon image of alarm. 

 Alarm Management: The List of Alarm Management, include State; Priority; Owner; Assigner; Time(assigned 
time of client local time); and Alarm Note (to note how users deal with the alarm) 

 Server Info/ Alarm Guide: The guide for how to deal with this alarm. 

To view live video from the alarm source camera: 

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Detail. 

2. Click Live Video. The Live Video Window for the camera is displayed. 

 

3. If you want to adjust the video to original video resolution, check Adjust to original video resolution. 

4. Click Snapshot button . The snapshot is displayed and users can save the image or copy it to the clipboard. 

5. Select Streaming profile button  to choose different video quality: includes Original/Main, Recorded, High, 
Normal, Low, Minimum.  

6. If the camera is equipped with Audio function, the Audio button will appear. Click the button  to disable audio 
stream. 

7. If the camera is associated to POS, the POS button  will appear. Click the button to disable POS information.  

8. To use PTZ control in a live video window: 

Alarm Management

Alarm Guide 

Basic Information 

Alarm Image 

Page - 56 



NUUO Central Management System 
Alarm Overview Window 

If the camera is equipped with remote PTZ (pan, tilt, zoom) control, the PTZ button will appear. Clicking this 
reveals the following controls: 

 

 Direction controls: U (up), D (down), L (left), R (right), H (Home) 

 Zoom out (-) and zoom in (+) controls 

 Focus controls 

 The Preset Point drop-down list. If preset points have been defined for the camera, these appear in 
the list. 

To view recorded video from the alarm source camera: 

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Detail. 

2. Click Recorded Video. The Remote Playback Window has full playback controls. 

 

3. If you want to fix the window size at the original resolution, check Fix original video resolution. 

 

The default playback period is 1 minutes. To viewer longer period, please right-click the device and choose 
the longer period which you want (see page 65) or use Remote Playback system which has full playback 

controls. In Tools menu, point to Remote Playback. 

To send Video to Matrix: 

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Detail. 

2. Click Send to Matrix and select Matrix which you set (see Matrix System, page 38). The video is sent to Matrix. 

To view POS Transact: 

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Detail. 

2. If the alarm has POS transact, the POS Data button will appear. Click POS Data. The POS transact data is 
displayed on the right. 

To view live video from a camera related to the alarm source I/O device or POS: 

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Detail. 

2. Click Related Device, then point to Open Live Window, and click the camera you want. The Live Video Window 
for the camera is displayed. 

3. If you want to fix the window size at the original resolution, check Fix original video resolution. 

To view recorded video from a camera related to the alarm source I/O device or POS: 

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Detail. 

2. Click Related Device, then point to Open Playback Window. 

3.  If you want to fix the window size at the original resolution, check Fix original video resolution. 
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To trigger a digital output device: 

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Detail. 

2. Click Related Device, then point to Trigger Digital Output, and choose the output device you want to trigger. 

To report/print alarm details: 

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Detail. 

2. Click Report/Print Alarm, then select the printer options you want and click OK. 

To set the alarm state, priority, owner and Note: 

There are two ways to manage alarm state, priority, and owner. One is in the Alarm Detail Window, and the other is in the 
Alarm Management Window, which is opened directly form the alarm event in the Alarm Overview window. 

 In the Alarm Detail window 

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Detail. 

2. In the Alarm Management area, select the State, Priority, owner and Note from the drop-down lists. If you want 
to reset these options to the settings when you opened the window, click Reset. 

3. Click Update to manage this alarm. 

 In the Alarm Management window: 

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Management. 

 

2. In the Alarm Management window, select the State, Priority, owner and Note from the drop-down lists. Click 
OK. 

Exporting Alarm Data to an Excel File 
Alarm data can be exported to an Excel file. You can do this for a single selected alarm, or for all alarms in the Alarm 
Overview window. The columns in the exported file are including AlarmName, Priority, State, EventType, SourceDevice, 
Owner, AlarmTime. 

 

To export a single alarm event to Excel: 

Right-click on any alarm event in the Alarm Overview window, then click Export Selected to Excel. 

To export all alarm events in the Alarm Overview window to Excel: 

Right-click on any alarm event in the Alarm Overview window, then click Export All to Excel. 

Clearing Alarms 
All alarm events can be cleared from the Alarm Overview window. 

To clear all alarm events: 

Right-click on any alarm event in the Alarm Overview window, and then click Clear All. 

Page - 58 



NUUO Central Management System 
Map Window 

Map Window 

Adjusting Map Appearance 
The display of map graphics in the Map window can be controlled. The size of the map can be selected, and the map 
moved in the window to show the required area. The brightness of the map graphic can also be changed without affecting 
the brightness of device indicators on the map. 

To control the size of a map: 

Either use the zoom in  and zoom out  buttons to adjust the map size, or click the magnify  button and select one 
of the following options: 

 Full Size 

 Fit Image 

 Fit Width 

 Fit Height 

To lock the map size: 

Click the magnify  button and then select Zoom Lock. This prevents the accidental changing of the map size. To turn 
Zoom Lock off, click it again. 

To pan when the map size is larger than the Map window: 

Click and drag the map to the position you want. 

To lock the map pan setting: 

Click the magnify  button and then select Pan Lock. This prevents accidental panning of the map. To turn Pan Lock off, 
click it again. 

 
The controls above can also be accessed on the Zoom menu. 

 

To adjust map brightness: 

Move the brightness slider  for the brightness you want. 

Navigating Between Map and Servers/ Devices 
It is easy to navigate between different layers of maps, and to show the maps for devices in various locations. There are 
two ways of doing this: clicking icons in MapView, and using indicators on the map. 

To navigate in MapView: 

Ensure that the MapView window is selected. Then either: 

 Click the icon  for the map you want to display. 

or 
 Click a device icon. The map which the device indicator is on will display. 

To navigate with indicators: 

Ensure that the MapView window is selected. Then click on a map indicator  to see the underlying (child) map. Click 

the Go to Parent Map button  to go to the parent map. 
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Searching for an Indicator on the Map 
Users can find device, server or map indicators on a map by using the Search function. 

To use the search function: 

1. On the Operate toolbar, click the Search icon . 

 

2. In the Search window, enter the full name or part of the name of the indicator you want to search for. 

3. Select from the following options: 

 Match case – searches for names where the case matches the letters you entered. 

 Match whole word only – searches for the term you entered as a whole word. If the term you entered forms 
only part of an indicator’s name, that indicator will not be found. 

 Look At Map/Server/Device – checking the boxes selects which kinds of indicator are searched. 

 Find In MapTree/ServerTree – if ServerTree is selected when the ServerView window is displayed, servers 
and devices in the ServerView window will be searched. 

4. Click Find Next to search for the indicator name. If an indicator is found, the map it is on will be displayed and the 
indicator will be highlighted. The corresponding icon in the MapView window will also be highlighted. 

5. If you want to search through multiple indicator names which include the same term, click Find Next until the 
indicator you want is found. 

 
You can also search indicators by entering a term in the Search box and pressing the Enter key on your 
keyboard. 

Map Indicators 
Indicators on a map provide a graphical representation of the connection and alarm states of the devices or servers they 
represent, or for map indicators the alarm state of devices on their child maps. The meaning of the various graphics is 
given below. 

 
Camera is connected and has no alarm 

 
Camera is disconnected and has no alarm 

 
Camera is connected and has New alarm 

 
Camera is connected and has Assigned, In Progress or Later alarm 

 
Server is connected and has no alarm 

 
Server is disconnected and has no alarm 

 
Server is connected and has New alarm 
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Server is connected and has Assigned, In Progress or Later alarm 

 
POS is connected and has no alarm 

 
POS is disconnected and has no alarm 

 
POS is connected and has New alarm 

 
POS is connected and has Assigned, In Progress or Later alarm 

 
Input device is connected and has no alarm 

 
Input device is disconnected and has no alarm 

 
Input device is triggered and has no alarm 

 
Input device is triggered and has New alarm 

 
Input device is triggered and has Assigned, In Progress or Later alarm 

 
Output device is connected but not triggered 

 
Output device is disconnected 

 
Output device is connected and triggered 

 
There is no alarm on underlying map 

 
There are New alarms on underlying map 

 
There are Assigned, In Progress or Later alarms on underlying map 

Map Display Settings 
You can control the appearance of text which accompanies device indicators, and the information it shows. 

To change the map display settings: 

In the Edit Menu, click Map Display Setting, and choose the desired configuration: 

 For text displayed above device indicators, select the font, font size, font color and any font effects desired. 

 If you want the server name displayed alongside the device name, select Show Server Name. 

 Select the background color, background transparency and camera coverage color for device indicator text. 
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Device Alarm Menus 

When a user right-clicks on a device indicator on a map, or on a device’s icon in the System Control window, a Device 
Alarm menu is shown. 

There are some commands which are common functions to all device alarm menus. These are: 

 View Latest Open Alarm – shows the latest open alarm (alarm with New status) for the device. 

 Query Alarm – displays open alarms (alarms with New status), or alarms for any particular date, for the device 

 System Information – gives information about the server. 

In addition, the Device Alarm menu shows different options depending on what kind of device you right-click on.  

For a camera, the menu shows the following options: 

 Open Live Video Window – opens a window with live video feed from the 
camera.  

 

 

 Open Playback Window – opens a recorded video playback window. 

 Backup Recorded Video – saves a backup of recorded video from the device, 
in the directory you specify. 

For a POS, the menu shows the following options: 

 POS Search – searches POS transaction by date, time and keyword  

 Open Live Video Window – opens a window with live video feed from the 
associated camera. 

 Open Playback Window – opens a recorded video playback window. 

 Backup Recorded Video – saves a backup of recorded video from the device, 
in the directory you specify. 

For an output device, the menu shows the following option: 
 

 Force Output – triggers a digital output device such as an audible alarm signal. 

For a server, the menu shows the following options: 

 Open Remote Desktop – opens a remote desktop for the server. 

 Backup Record Video – saves a backup of recorded video from any or all of 
the cameras on the server, in the directory you specify. 

Common Functions  
The View Latest Open Alarm, Query Alarm, and System Information commands are common to all device alarm menus. 

To view the latest open alarm for a device: 

1. Right-click on the indicator for the device, or on the device’s icon in the MapView display. 

2. Click View Latest Open Alarm. 

3. The Alarm Detail Window for the latest alarm opens. For information on this window, see page 55. 

To query alarms for a device: 

1. Right-click on the indicator for the device, or on the device’s icon in the MapView display. 

2. Point to Query Alarm, then choose which alarms you want to see: 

 Open – shows all open alarms. 
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 Today – shows alarms from the current day. 

 Custom – opens the Calendar Dialog window. Choose a date, then click OK. 
 

System administrators set the length of time that alarms are stored on the server (see page 37). If you 
choose a date for which alarm information is not stored, the No alarm found on the device message is 
displayed. 

 

 
3. The query results are display in the Output/Output 2 tab. For information on this window, see page 54. 

To show information about the server: 

1. Right-click on the indicator for the device, or on the device’s icon in the MapView display. 

2. Click System Information. 

 

Camera Alarm Menu 
The Open Live Video Window, Open Playback Window, and Backup Recorded Video commands appear on the device 
alarm menu for cameras. The first two options are the same as on the Alarm detail Window (see pages 55-58). 

To open a live video window: 

1. Right-click on the indicator for the camera, or on the camera’s icon in the MapView display. 

2. Click Open Live Video Window. The Live Video Window for the camera is displayed. 

 

3. If you want to adjust the video to original video resolution, check Adjust to original video resolution. 

4. Click Snapshot button . The snapshot is displayed and users can save the image or copy it to the clipboard. 

5. Select Streaming profile button  to choose different video quality: includes Original/Main, Recorded, High, 
Normal, Low, Minimum.  
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6. If the camera is equipped with Audio function, the Audio button will appear. Click the button  to enable audio 
stream. 

7. If the camera is associated to POS, the POS button  will appear. Click the button to disable POS information.  

8. To use PTZ control in a live video window: 

If the camera is equipped with remote PTZ (pan, tilt, zoom) control, the PTZ button will appear. Clicking this 
reveals the following controls: 

 

 Direction controls: U (up), D (down), L (left), R (right), H (Home) 

 Zoom out (-) and zoom in (+) controls 

 Focus controls 

 The Preset Point drop-down list. If preset points have been defined for the camera, these appear in 
the list. 

To open a recorded playback window: 

1. Right-click on the indicator for the camera, or on the camera’s icon in the MapView display. 

2. Point to Open Playback Window.  

3. Select the period which want to display. 

 Last Open Alarm- it would open one minute recording video before last open alarm. 

 Custom Time- it can set Start/End time to define the period of recording video. 

 

 One Minute Before- open one minute before. 

 Ten Minutes Before- open ten minutes before. 

 One Hour Before- open one hour before.  

4. The Remote Playback Window has full playback controls. 

5. If you want to adjust the video to the original video resolution, check Adjust to original video resolution. 

6. Click Snapshot button . The snapshot is displayed and users can save the image or copy it to the clipboard. 

7. Click Export Video button to save recorded video.  

 Set up the cue in and cue out points; the cue in and cue out time will show on the information window. 

 Click Export Video button, choose the folder where you want to save the file at, enter the file name and click 
SAVE. 

 Set the Export Format as ASF or AVI (ASF recommend) and set the Use Profile. 

 Select to export (i.e. save) the record video with Audio, OSD and POS, or export video only. 

 Click OK to save the video. 
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8. If the camera is equipped with Audio function, the Audio button will appear. Click the button  to enable audio 
stream. 

9. If the camera is associated to POS, the POS button will appear. Click the button to disable POS information.  

To back up recorded video: 

1. Right-click on the indicator for the camera, or on the camera’s icon in the MapView display. 

2. Click Backup recorded video. 

3. In the Remote Backup Recorded Video window, choose a directory for the backup by pressing the URL button 

 and browsing to the directory you want. 

4. Setup the Time Zone and use setting Start/End Time to select a period.  

5. Use the checkboxes to select which cameras to back up video for. 

6. Click on OK to start backup. 

 

To Set up Stream Profile: 

1. Right-click on the indicator for the camera, or on the camera’s icon in the MapView display. 

2. Click Stream Profile. 

3. In the Stream Profile Panel, choose Recorded, Original, High, Normal, Low or Minimum for the stream 
profile to change video format, frame rate, resolution, quality and bitrate. 

4. Click Apply to set up. 

5. If you want to apply the Stream Profile setting to other cameras, click Apply to to set up another device. 

 

POS Alarm Menu 
The POS Search, Open Live Video Window, Open Playback Window, and Backup Recorded Video commands 
appear on the device alarm menu for the POS. The steps are the same as on the Camera Alarm Menu (see pages 64). 
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To search POS transaction: 

1. Right-click on the indicator for the POS, or on the POS’s icon in the MapView display. 

2. Click POS Search. POS Search Dialog will display 

3. Setup the Date/Time for search: 

 Date/Time – check Date and/or Time; and From and/or To, in the checkboxes. Then choose the date/s and 
time/s you want. 

4. Enter keyword to search POS transaction. Click Search within result to filter the result. 

5. Choosing a result to display POS transaction and video from associated camera.  

To open a live video window: 

1. Right-click on the indicator for the POS, or on the POS’s icon in the MapView display. 

2. Click Open Live Video Window. The Live Video Window for the POS is displayed. 

 

3. If you want to adjust the video to the original video resolution, check Adjust to original video resolution. 

4. Click Snapshot button . The snapshot is displayed and users can save the image or copy it to the clipboard. 

5. Select Streaming profile button  to choose different video quality: includes Original/Main, Recorded, High, 
Normal, Low, Minimum.  

6. If the camera is equipped with Audio function, the Audio button will appear. Click the button  to enable audio 
stream. 

7. Click the button to disable POS information.  

8. To use PTZ control in a live video window: 

If the camera is equipped with remote PTZ (pan, tilt, zoom) control, the PTZ button will appear. Clicking this 
reveals the following controls: 

 

 Direction controls: U (up), D (down), L (left), R (right), H (Home) 

 Zoom out (-) and zoom in (+) controls 

 Focus controls 
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 The Preset Point drop-down list. If preset points have been defined for the camera, these appear in 
the list. 

To open a recorded playback window: 

1. Right-click on the indicator for the POS, or on the POS’s icon in the MapView display. 

2. Point to Open Playback Window.  

3. Select the period you want to display. 

 Last Open Alarm- this opens one minute of recording video before the last open alarm. 

 Custom Time- this sets the Start/End time to define the period of recording video. 

 

 One Minute Before- open one minute before. 

 Ten Minutes Before- open ten minutes before. 

 One Hour Before- open one hour before.  

4. The Remote Playback Window has full playback controls. 

 

5. If you want to adjust the video to the original video resolution, check Adjust to original video resolution. 

6. Click Snapshot button . The snapshot is displayed and users can save the image or copy it to the clipboard. 

7. Click Export Video button to save recorded video.  

 Set up the cue in and cue out points; the cue in and cue out time will show on the information window. 

 Click Export Video button, choose the folder where you want to save the file at, enter the file name and click 
SAVE. 

 Set the Export Format as ASF or AVI (ASF recommend) and set the Use Profile. 

 Select to export (i.e. save) the record video with Audio, OSD and POS, or export video only. 

 Click OK to save the video. 

8. If the camera is equipped with Audio function, the Audio button will appear. Click the button  to enable audio 
stream. 

9. Click the button to disable POS information.  

To back up recorded video: 

1. Right-click on the indicator for the POS, or on the POS icon in the MapView display. 

2. Click Backup recorded video. 

3. In the Remote Backup Recorded Video window, choose a directory for the backup by pressing the URL button 

 and browsing to the directory you want. 

4. Setup the Time Zone and use setting Start/End Time to select a period.  

5. Use the checkboxes to select which cameras to back up video for. 
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6. Click on OK to start backup. 

 

 

Output Device Alarm Menu 
The Force Output command appears on the device alarm menu for output devices. 

To force output: 

1. Right-click on the indicator for the output device, or on the output device’s icon in the MapView display. 

2. Click Force Output. A signal is sent to trigger the output device. 

Server Alarm Menu 
The Backup Record Video and Open Remote Desktop commands appear on the device alarm menu for servers. 

To back up recorded video: 

1. Right-click on the indicator for the server, or on the server’s icon in the MapView display. 

2. Click Backup recorded video. 

3. In the Remote Backup Recorded Video window, choose a directory for the backup by pressing the URL button 

 and browsing to the directory you want. 

4. Setup the Time Zone and use setting Start/End Time to select a period.  

5. Use the checkboxes to select which cameras to back up video for. 

6. Click on OK to start backup. 

To open a remote desktop for the server: 

1. Ensure that the source server has enabled the Remote Desktop network server. 

2. Right-click on the indicator for the server, or on the server’s icon in the MapView display. 

3. Click Open Remote Desktop. 

Advance Alarm Search 
The Advance Alarm Search window provides a comprehensive set of filters to search for alarm events. The results can be 
displayed either in the Output window or the Output 2 window. 

To use Advance Alarm Search: 

4. In the Tools menu, click Advance Alarm Search. 

5. In the Advance Alarm Search Dialog window, check the box or boxes for the search criteria you want, then 
choose the desired options (if no options are selected for a given field, it means search for all). 
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6. Setup the General options for criteria: 

 Alarm Name – choose a name from the drop-down list. 

 Owner Name – choose a name from the drop-down list. 

 Alarm State – choosing Open or Close in the first list reveals different states in the second list: 

 Open – All, New, Assigned, In Progress, or Later in the second list.  

 Close – All, Close, Auto Close, or Ignore in the second list. 

 Alarm Priority – click the button to cycle through Greater than, Equal to, and Less than. In the drop-down list, select a 
priority. 

 Alarm Note – enter keyword for search  

7. Setup the Date/Time for search: 

 Date/Time – check Date and/or Time; and From and/or To, in the checkboxes. Then choose the date/s and time/s you 
want. 

For setup one day as the search period, click  icon by the side of Time 

and select 1 day. Or manual enable  and set date from 2008/3/16 to 
2008/3/17.  

 
8. Choose the Source Device and Event Message. 

 Source Device – check the box or boxes for the devices you want to search. If only check the Source Device without 
select any devices from tab, the criteria would search for all devices.  

 Event Message – check the box or boxes for the event messages you want to search. If only check the Event 
Message box without select any events from tab, the criteria would search for all events.  

9. Click Add Filter Criterion. The search criteria you selected appear in the window. 

10. You can edit or remove the set of search criteria you have just created, or add another set of search criteria: 

 To edit a set of search criteria, select that set, choose filter options as described above, then click Update Filter 
Criterion. 

 To remove a set of search criteria, select that set, then click Delete Filter Criterion. 

 To add another set of search criteria, choose filter options as described above, then click Add Filter Criterion, the 
search result would include each combination of all criteria. 

11. By default, search results are displayed in the Output window. If you want the results to be displayed in the 
Output 2 window, check Output to Pane 2. 

12. Click Search. 
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Matrix View 

The NCS Client provides feeds over the Internet to multiple video matrixes. Each matrix can display images from up to 64 
cameras, along with text above each image including information about the camera and server. Matrixes can also be 
configured to show video from a camera when an alarm event occurs. To display video on a matrix, the NCS client must be 
logged in to that matrix. Once logged in, the matrix display can be configured and cameras chosen. 

Matrix View Toolbar 
The Matrix View Toolbar has the following buttons: 

 Login/Logout matrix   – the NCS Client must be logged in to a matrix in order for most of the Matrix 
Toolbar commands to be used. 

 Remove camera on matrix  – when a camera icon on a matrix  is selected, clicking this button removes it. 

 Reset matrix  – this button removes all cameras from the selected matrix. 

 Toggle allow show video on event  – this is a toggle button. When selected, you can enter edit mode to set 
that video from a camera and related cameras can be displayed on the matrix when an alarm event occurs. 

 Toggle auto scan  – this allows auto scanning of cameras on the matrix.  

 The Profile button  – this opens the Profile menu. For information on this see below. 

 The Audio button  – this enables camera audio. 

 The Matrix grid buttons  these control the layout of the matrix grid. 

Showing Video on a Matrix 
Showing video on a matrix requires that a matrix system be executed, either on the same computer as the one running the 
NCS Client, or another one. For information on how to execute a matrix system, see page 38. For the NCS Client to show 
video on a matrix, it must be logged in to that matrix. 

To load a preset matrix profile: 

Click the Profile button and point to Load Profile, then click the profile you want to load. 

To log in to a matrix: 

Select the matrix you want to log in to and click the Login matrix button . 

To configure a matrix grid layout: 

1. Ensure that the NCS Client is logged in to the matrix as described above. 

2. Select the matrix you want to configure. 

3. Click one of the Matrix grid buttons . The button on the far right is the Matrix Grid NxN 
button. Clicking the arrow next to this displays a menu, from which you can select more display grid options. 

To select the cameras on a matrix: 

1. Ensure that the NCS Client is logged in to the matrix as described above. 

2. Select the matrix you want to configure. 

3. Click the Profile button and point to Select Cameras on Matrix. 

4. In the Select Cameras on Matrix window, check the cameras that you want to appear on the currently selected 
matrix, then click OK. 
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5. The camera icons appear on the matrix. You can drag them to different positions on the matrix. To see which 
camera a particular icon represents, point to the icon. A text bubble appears showing the camera name, type, and 
server. 

6. Select Stream Profile of the camera. Choose As NCS Client, Original/Main, Recorded, High, Normal, Low or 
Minimum. 

 

 
You can also drag cameras to the matrix by clicking a camera indicator on a map, and dragging it to the 
matrix. To do this, the NCS Client must be in Operate mode. 

You can disable the Link between the Map and Matrix by clicking  the Disable Link between Map and 

Matrix button .  

 You can disable send video on event to Matrix by clicking the Disable to Matrix button . 

Video of new alarm events cannot replace old events on the Matrix if the Matrix is full and users do not 

close old events when you click The Disable Matrix Popup button .  

 

To remove a camera from a matrix: 

1. Ensure that the NCS Client is logged in to the matrix as described above. 

2. Select the matrix you want to configure. 

3. Select the camera icon and click the Remove camera on matrix button . 

The setting of Matrix can only save on NCS client PC. The same user account login server with different 
PC can’t load the original Matrix setting.  

To reset matrix: 

1. Ensure that the NCS Client is logged in to the matrix as described above. 

2. Select the matrix you want to configure. 

3. Click the Reset matrix button  

To toggle allow show video on event: 

1. Ensure that the NCS Client is logged in to the matrix as described above. 

2. Select the matrix you want to configure. 

3. Click the Toggle Allow Show Video on Event button .or select Edit “Show On Event” Mode. Select grids 
you want to show video on events. Clicking again can disable allow show video on events. 

4. Choose Select  All to toggle allow all grids show video on events. 

5. Choose Clear  All to disable allow all grids show video on events. 

To toggle auto scan: 

1. Ensure that the NCS Client is logged in to the matrix as described above. 

2. Select the matrix you want to configure. 

3. Click Toggle Auto Scan button . 

4. Click Toggle Auto Scan button again to disable auto scan. 

 

Joystick Control 
Matrix system can be controlled by a joystick. Prior to setup, it requires a joystick device connected to NCS Client computer. 
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To setup Joystick Control: 

1. Click the Edit button and point to Joystick Setting.  

2. In Joystick Setting Window, select the Active Joystick you want to use. 

3. Select the function and the parameter from drop-down menu for the button of joystick. The function are as below: 

 N/A – make the button ineffective. 

 Goto Preset Point – go to the preset point of the view on a matrix or a live video. Select the parameter for the preset 
point. 

 

 Goto Previous View – go to previous view on a matrix. 

 Goto Next View – go to next view on a matrix. 

 Switch Matrix Grid – switch grids of a matrix. 

 Toggle Single Camera View – toggle select camera to single view. 

 Start/Stop Autoscan –start/stop autoscan on a matrix. 

 Zoom Wide – zoom wide of the view on a matrix. 

 Zoom Tele – zoom tele of the view on a matrix. 

 Switch Active Matrix – switch into different matrix. 

 Goto Matrix View – go to Matrix View Window.  
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Remote Playback Shortcut 
The Remote Playback command in the Tools menu displays a NUUO NVR/NDVR/DVR control screen from the server. 
For information about the NUUO NVR/NDVR/DVR software, see its accompanying documentation. 

To execute the Remote Playback shortcut: 

1. In the Tools menu, click Remote Playback. 

2. For multiple monitor systems, select which monitor you want the NVR/NDVR/DVR control screen to display on. 

 

3. Click OK. 
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Server Summary 
The Server Summary window displays summary information about all the source servers connected to the NCS Client. 

 

This information consists of: 

 Login – the login name for the recording server. 

 Recording – the video recording status of the recording server. 

 Free Disk Space – remaining recording server disk space. 

 Camera Count – the number of camera licenses connected to the recording server. 

 I/O Count –the number of input and output devices connected to the recording server. 

 POS Count –the number of POS devices connected to the recording server. 

 Time Zone – the time zone of the recording server. 

 License Status – the license status of the NSC system  

 Total License – the total number of  licenses, including cameras, POS and I/O devices. 

 Remaining License – the remaining number of licenses, including cameras, POS and I/O devices. 

To use the Server Summary window: 

1. In the Tools menu, click Server Summary. 

2. Use the  and  buttons beside the server group folders to view server information. 

3. To refresh the information in the window, click Refresh. This refreshes Login User, Recording status and Free 
Disk Space. To refresh number of cameras, IO, and Time Zone, select Synchronize Device while in Edit Mode. 

To open a window with more detailed server information: 

In the Server Summary window, select a server, then click Detail. 
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NCS Client Software version 
To view the NCS Client software version: 

In the Standard Toolbar, click  to see version information. Alternatively, in the Help menu, select About Central. 
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Cross Time Zone Scenario 

The NCS System is easy to use across multiple time zones. The NCS Server and the SQL database record all alarm times 
in UTC (Coordinated Universal Time). This enables the NCS Server to put the alarms in order before they are sent to the 
NCS Client. The NCS Client converts the alarm times to the local time, to enable users to manage alarms efficiently. 

If required, NCS Client users can access source devices’ local times in the Alarm Detail window and the Alarm Overview 
window (see Alarm Log Settings on page 55). 
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